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Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python

Organisatorisches

Zielgruppen

o Lehramt Sonderpad./Obersch./Gym. 8. Sem.

® Bestehen des Kurses ist Prifungsvorleistung (Vorauss. fur
Klausurteilnahme) fur Numerikvorlesung Dr Radl

o Dipl. Math/WiMa 4. Sem.

® Kurs ist freiwillig zur Vorbereitung auf das Numerische Praktikum
von Prof. Kunkel

® nicht als Thema in mundl. Prufungen

® nicht als Informatik-Praktikum (WiMa)
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Organisatorisches

Erfolgreiche Teilnahme
ist definiert als:

o erfolgreiche Losung von > 3 Programmieraufgaben
(s. Webseite zum Kurs in den nachsten Wochen)

® davon eine Aufgabe aus der Gruppe Aufgaben 1-10
® und zwei Aufgaben aus der Gruppe Aufgaben 11-23

o Zweier-, Dreier- und Vierergruppen zulassig
o nicht im 14-Tage-Rhythmus, bis zur letzten VL-Woche
o Vorstellung im Computerpool bei mir
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Ziel und Inhalt

@ Einfithrung in Python

(keine Objektorientierung, Metaklassen, etc...)
@ Schwerpunkt auf numerische Anwendungen
@ Die Bibliothek NumPy fur numerisches Python
o Die Bibliothek MatPlotLib fur Plots/Graphen

import numpy as np
import matplotlib.pyplot as plt
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for i in range(0,4): 05
x = np.sin(a[i] * t + delta) ooy
y = np.sin(b[i] * t)
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plt.plot(x,y)

plt.show()
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Most In-Demand Languages
Indeed Job Openings - Dec. 2017
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Warum Python?

Vielseitige Sprache: prozedural | objektorientiert | funktional

Free & Open Source
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@, python’

Implementierungen fur alle gangigen Betriebssysteme

Q
o
o
o Interpreter, Just-in-time Compiler, Cython, Jython
@ Umfangreiche Bibliotheken und Module

Q

Schlanke Syntax
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Schlanke Syntax

Java

public class HelloWorldApp {
public static void main(String[] args) {
System.out.println("Hello World!");
}

Python

print("Hello World!")
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@, python

Geschichte

1991 first release, version 0.9
1994 Python 1.0
2000 Python 2.0
2008 Python 3.0

o z. Zt. 2 Dialekte, Python 2 und Python 3

O Aktuelle Arbeit an Python2: bug fixing und
backporting von Python3-Features

o Aktuell: 15.Marz 2019 Python 3.7.3
3. Marz 2019 Python 2.7.16

Guido van Rossum (2006)

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python 8/75



Werbepause @ 502

[+ ]
‘solve([x‘E + b*x + ¢ == 0],x)
4
B(—iv3+1 3 B(iv3+1 i
z= (Civ3+1) . —%(—%c+%‘f§b’+9cﬂl (iv3+1),z= (iv3+1) - —%(—%c+%ﬂ§b’+98] (—iv3+
6(—§c+%,/§bﬂ+9cﬂ}’ 6(7%c+%1/§b3+90'2}’
a
[+

‘f = 1/((1+x) *(x-1)"2)

[+ ]
‘f.partial_fraction(x)

I | 1|
d@+1) Aw-1)  2(z-1)|

0=
‘diff(sin(x"?), x, 4)

16* sin (z*) — 48 2° cos (z?) — 12 sin (z°)|

[+
‘ integral(x™3/sgrt(x"2+1), x)

%,/a’+1z‘— ; N

SageMath auf Python basierendes Computeralgebrasystem
free&open source www . sagemath.org

[+ =
solve([x™3 + b*x + ¢ == 0],x)
1
b(—14/3+1 3 b(iv3+1
= (-iv3+1) - S (L1 R e ’(i\/?+1],z= (iva+1) . S (R
1 1 /3 3 2 2 6 3 1 L /1 3 2 2
4
[+

‘f = 1/((1+x)*(x-1)~2)

[+ =
‘ f.partial fraction(x)

1 _ 1 I 1
4(z+1) 4(z-1) 2(z-—1)*

[+ =]
‘diff(sin(x“?), x, 4)

16z* sin (z?) — 48 2” cos (z?) — 12 sin (z?)|

[+ =
‘ integral (x™3/sqgrt(x™2+1), x)

1 2
5\1324—132—5 $2+1


www.sagemath.org

Nutzungsmoglichkeiten

1. Python-Notebook-Webserver
https://milab7.mathematik.uni-leipzig.de/

2. Computerpool Mathematik (unter Linux)

3. Wenn Sie mochten:
® Linux: Installieren Sie mit dem Software-Manager |hrer
Linux-Distribution Python3 sowie die Python3-Pakete numpy,
matplotlib, spyder und bei Bedarf scipy, ipython/jupyter
® Als Alternative konnen Sie auch Anaconda fur Linux installieren.
® Windows/MacOS: z.B. Python-Distribution ,Anaconda” (enthalt alle
notigen Pakete)
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Python ausfiihren
1. Interaktiv: Konsole/Terminal/Eingabeaufforderung/cmd.exe
python3

Python 3.7.3rcl (default, Mar 13 2019, 11:01:15)
[GCC 8.3.0] on linux

Type "help", "copyright", "credits" or "license" for more information.
>>>
>>> 2%%64-1
18446744073709551615
>>> def sum_powers(n):

s=0

for i in range(n):

S += 2%*i
return s

>>> sum_powers(5)

31

>>> sum_powers(64)
18446744073709551615

>>> sum_powers(64) == 2xx64 - 1
True

>>> quit()
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https://milab7.mathematik.uni-leipzig.de/

Python ausfuhren

2. Konsole + Texteditor

a hellmund@minbll4: /fhome/hellmund
File Edit View Search Terminal Help
hellmund@minbll4:~>
hellmund@minbl14:~>python3 perfect.py
Choose a number, "0" to quit: 2

Pech

Choose a number,

"0" to quit: 3

number, "0" to quit: 4

number, "0" to quit: 5
number, "0" to quit:

I 6 ist vollkommen!
number, "0" to quit:
number, "0" to quit:
number, "0" to quit:

1 28 ist vollkommen!
number, "0" to quit:

Choose a number,
hellmund@minbl14:

"0" to quit:
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Python ausfiihren

Emacs: /home/hellmund/perfect.py
File Edit Options Buffers Tools Python Help

"0" to quit: '))

for i in range (1,nb):
if nb%i==0:
m+=1i
if (m==nb):
print("Treffer!", nb ," ist vollkommen!")
else:
print{{'Pech '}

perfect.py A1l of 274 (14,21) (Python)

TR Y

5. IDE (Integrated development environment), z.B. Spyder:

2 O @ spyder
File t arc

TE RO

Editor - fhome/carlos/Escritorio/montecarlo_pi.py
Ty . Interpolation.py

1
2
3 """Simple generation of pi via MonteCarlo integration.
4 Taken from the Py4Science Workbook.
5w
6 import math
7 import random
A 8 import numpy as np
9 from scipy import weave

Dk = e e

) " v é $ » ™= =
® Object inspector [E3]

@ montecarlo_pi.py 3 B

10

11 def wl({n = 100000): )
12 """Approximate pi via monte carlo integration""" a:array_like
13 rand = random.random Array containing numbers whose mean is desired. If ais
14 sqrt = math S:I]r“t not an array, a conversion is attempted. -
L= sm=0.0 Object inspector | Variable explorer File explorer
16 for i in xrange(n):
17 sm += sqrt(l.0-rand ()**2)
18 return 4.0%sm/n L ®
19
20 def v2(n = 100000): “v| % IPython1 % % IPython 2 % 00:01:15 [Ev A
21 """Implement vl above using weave for the C call"""
%% suspozt"i #include <stdlib.h= In [2]: sin([1,2,3])
5 ;gugle_ . Outl2]: array([ 0.84147098, 0.90929743, 0.14112001])
25 float rnd; In [3]: |
26 srand(1); // seed random number generator '
) sm = 0.0;
28 for{int i=0;i<n;+i) {
29 rnd = rand()/(RAND_MAX+1.0);

g = - . v .
30 sm += sart(1.0-rnd*rnd): S Console  History log

Permissions: RW End-oflines: LF Encoding: UTF-8 Line: 16 Column: 1

mean(a, axis=None, dtype=None, out=None)
Function of numpy.core.fromnumeric module

Compute the arithmetic mean along the specified axis.
—J Returns the average of the array elements. The average is taken

over the flattened array by default, otherwise over the specified axis.
float64 intermediate and return values are used for integer inputs.

Parameters

Meik Hellmund (Uni Leipzig)
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Python ausfiihren

4. Jupyter/IPython Webinterface - Python Notebooks
TIPIvl: Notebook bifurcation  Last saved: Aug 119:19 PM

‘ File Edit View Insert Cell Kernel Help

] x L] u] t + T 3 > = | Code =

Bifurcation Plots. System xnew =r * X * (1-x). As r increases, system stabilizes to one value, then 2, 4, and chaos.

In [1]: def bifur(rspace, y=(0,1), INIT PTS=500, PLT PTS=500):
""" Bifurcation plot with parameter r sweeping over rspace. """
rlen = len(rspace)
x = empty((rlen, INIT PTS+PLT PTS))
Xx[:,0] = ones(rlen) * 0.1 # Initial value
for i in range(INIT_PTS+PLT PTS-1):
x[z,i+l] = rspace * x[:,i] * (l-x[:,i])
plot( rspace,x[:,INIT PTS:],ls='', marker='.', markersize=1, markeredgewidth=0, color='red' )
ylim(y)

In [2]: %time bifur( linspace(l,4,1000) )

CPU times: user 0.46 s, sys: 0.02 s, total: 0.48 s
Wall time: 0.47 s

10

o8

06

04

02

0"].0 15 20 25 30 35 40

[Quelle: http://www.collindelker.com/wp/2012/08/fractal-art/ ]
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Python Notebook Webinterface “Jupyter”

o Auf https://milab7.mathematik.uni-leipzig.de/ einloggen
@ Login: NumLAG®1, NumLAGO2, ..., NumLA110

o Verzeichnis Ihrer Dateien erscheint:
Python Notebooks haben die Endung .ipynb

o Notebook laden oder mit New -> Python3 neues Notebook
aufmachen oder mit Upload hochladen

@ Am Ende bitte immer rechts oben Logout!


http://www.collindelker.com/wp/2012/08/fractal-art/
https://milab7.mathematik.uni-leipzig.de/

Python Notebook Webinterface “Jupyter”

@ Notebooks bestehen aus cells, diese konnen Python-Anweisungen
oder anderen Text enthalten.

@ Nitzlich: File-> Save&Checkpoint, File-> Rename,
Help-> Keyboard Shortcuts

@ Ausflihen von Python-Cells:

® Strg-Enter:run cell
® Shift-Enter:run cell, move cursor to next cell
® Alt-Enter:run cell, insert new cell below

Jupyter magic commands
Wir brauchen nur:

smatplotlib notebook

damit Matplotlib-Plots im Notebook als Grafiken erscheinen.

@ Am Ende: File-> Close&Halt

Qo Logout
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def teiler_test(i):
""" berechnet Anzahl der Teiler und Summe der Teiler von i """
n=0; s=20
for k in range(i):
if i%(k+1l) == 0:
n += 1
s += k+1
return (n, s)

# main program starts here
while True:
str = input("Bitte natlirliche Zahl eingeben, '0Q' fir Abbruch:")
i = int(str)
if i==0:
break
numTeiler, sumTeiler = teiler_test(i)
if numTeiler ==
print("Oha! Eine Primzahl!")
elif sumTeiler == 2xi:
print("Glickwunsch! Eine vollkommene Zahl!")
else:
print("Leider keine vollkommene Zahl. Sie hat ubrigens ",
numTeiler, " verschiedene Teiler.")
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Namen von Variablen, Funktionen, Klassen usw.
o beliebig lang, aus Buchstaben, Ziffern und Unterstrich
o erstes Zeichen mufd Buchstabe sein

o Grof3- und Kleinbuchstaben werden unterschieden
Nmax und NMAX sind verschiedene Variablen

o Zeichensatz: Unicode in UTF-8 Kodierung
o 33 reservierte keywords:

False None True and as assert break
class continue def del elif else except
finally for from global if import in

is lambda nonlocal not or pass raise
return  try while with yield

@ zulassig:i, x, m,x23, DieUnbekanntezZahl, neuer_Wert,
Zahler, K3J, delta, 0
unzulassig: 3achsen, A#b, $this_is not_Perl, del
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Python ist zeilenorientiert

o Im Normalfall enthalt jede Zeile genau eine Anweisung.

o Wenn eine Zeile mit einem backslash endet, wird die Anweisung
fortgesetzt:

if 1900 < year < 2100 and 1 <= month <= 12 \
and 1 <= day <= 31 and 0 <= hour < 24 \
and 0 <= minute < 60 and 0 <= second < 60:
date_valid = True

o Bei einer offenen Klammer (), [1, {} kann der backslash

entfallen:

Monatsnamen = ['Januar', 'Februar', 'Marz', 'April', 'Mai’,
"Juni', 'Juli', 'August', 'September',
'"November', 'Dezember']

o Mehrere Anweisungen pro Zeile konnen durch ein Semikolon
getrennt werden:

x=33; X += 22; print(x)
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Blacke werden durch Einriickung beschrieben

o Rucke ein, um einen Block zu beginnen.
o Rucke die nachste Zeile wieder raus
bis zum vorherigen indentation level, um den Block zu beenden.
o GroRe der Einrickung egal. Empfohlen: 4 Leerzeichen.
o Don’t mix tabs and spaces.
o Anweisungen, die einen Block einleiten, enden in der Regel mit
einem Doppelpunkt.

def f(x, z):
n=17
while z>0:
if x==0:
return n
else:
z-=1
n=n+z
z=Z-X
return 2xn

m=f(3,4)

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python 21/75

Blockstruktur

def f(x,z):

n=17

while z>0:

if x==0:
return n

n=n+2z

Z=7Z-X

\. J

return 2xn

[m:f(3,4) ]
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Grundlagen der Syntax

Kommentare
o Kommentare erstrecken sich von einem # bis zum Zeilenende
o Wie man es nicht unbedingt machen sollte:

Fh ok sk 5k k >k >k 3k >k 5k sk >k 5k 3k >k 5k >k >k 5k >k >k 3K >k >k K >k >k 3k >k 5k 3k >k >k >k >k 5k >k >k 3k >k >k kK >k >k >k >k >k >k >k >k 5 >k >k % >k K

# Die folgende Funktion berechnet das Quadrat einer Zahl
FE ok sk ok sk sk ok sk sk ok sk sk ok sk ok ok sk ok ok >k ok 3k sk ok sk sk ok sk sk ok sk sk ok ok ok K >k ok 3k sk ok s sk ok ok sk ok ok ok ok >k ok ok >k k ok

def square(x):

X2 = X * X # hier wird das Quadrat berechnet!!!!
return x2 )
Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python 23/75

Nutzung von Modulen
Module stellen Funktionen, Klassen, Objekte, Konstanten,... zur
Verfugung.
Sie mussen vor ihrer Verwendung importiert werden.
Verschiedene Formen:

import math
X math.sin(3/20 * math.pi)
y math.sqrt(7)

import math as mt
X mt.sin(3/20 * mt.pi)
y mt.sqrt(7)

from math import sin, sqrt as qwurz, pi
X = sin(3/20 * pi)
y = qwurz(7)
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Python-Module

Python standard library
o uber 100 Module, die bei jeder Python-Installation dabei sind

@ math, cmath, decimal, fractions, re, textwrap, datetime,
itertools, os, threading, email, html, xml, urllib,

PyPI - The Python Package Index

O pypi.python.org
o uber 50000 Pakete, leicht nachinstallierbar
@ z.B. matplotlib, numpy, scipy

o Andere und selbstgeschriebene Module )
Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python 25/75
Datentypen

@ Python ist stark typisiert: Alle Objekte haben einen Typ.
Ein String (Zeichenkette) str ist etwas anderes als eine ganze Zahl
int ist etwas anderes als eine FlieRkommazahl float etc...

@ Aber: Variablen sind nur typlose Referenzen auf Objekte.
Sie werden nicht deklariert und konnen verschiedene Typen
referenzieren.

@ Python hat ein dynamisches Typsystem. Der Typ eines Objekts wird
erst gepruft, wenn das Objekt verwendet wird.

X =3 # x existiert jetzt und ist ein Integer
X = "bla" # jetzt ist x ein String
X = x + "blub" # 1ist fir den Typ von x, also "str",
# eine Addition definiert? Ja!
print(x)
'blablub’

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python 26/75


pypi.python.org

Datentypen

Numerische Typen: int, float, complex
Logische Variablen: bool mit den Werten True und False
Zeichenketten: str, bytes, bytearray
Container: list, tuple, dictionary, set,

Zusatzliche Bibliotheken/Module definieren zahlreiche zusatzliche
Klassen/Typen, z.B.:

numpy: int32, int64, float32, float64,...
matplotlib: plot, axes,...

datetime: date, time, tzinfo,...
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Strings (Zeichenketten)

s = 'Ein String'

sl = "Auch ein String"

s2 = "Bei uns tag's und nacht's ged6ffnet"
s3 = """Ein Text uber

mehrere Zeilen mit ' und " im

Text"""

#

# backslashes | haben eine Spezialbedeutung
s4 = "Auch ein\nText Uber 2 Zeilen"

#

# in 'raw strings' entfallt die Spezialbedeutung:

s5 = r"Das ist nur\n eine Zeile mit einem backslash"
# strings sind Sequenzen von Unicode-Zeichen
s6="Rgéace"

Das ' ist kein Akzent sondern das Zeichen, welches auf deutschen Tastaturen
rechts neben dem a und Uber dem # liegt.
Das " ist die Doppelquote uber der Ziffer 2.
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Einige Stringfunktionen

>>> s = "Automobil" >>> s.replace("Auto","Perpetuum") + "e"
>>> s,startswith("Au") 'Perpetuummobile'’
True >>> s.find("om")
>>> s + " Fahrrad" 3
'Automobil Fahrrad' >>> s[3]
>>> 2 % § ‘o'
'AutomobilAutomobil' >>> "om" in s
>>> s[1:5] True
"utom' >>> S
>>> s[-1] Automobil
1
>>> len(s) Strings sind immutable. Funktionen wie
9 str.replace() andern das Stringobjekt nicht
sondern produzieren einen neuen String.
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Listen
1 =11 # leere Liste
1 = [42] # Liste mit einem Element
1 =11, 2, 33 1] # Liste mit 3 Elementen
1 =[1, 2, 33, 1] # dieselbe Liste
1 =1[2, "bla", 2.4 ] # Elemente konnen verschiedenen Typ haben
1=1[[1, 2], [3, 41, [5, 611 # list of lists
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Einige Listenfunktionen

>>> 1 = [3, 2]
>>> l.append(7)
>>> 1

[3, 2, 7]

>>> 1 =1+ [1,9]
>>> l.reverse()
>>>

(9, 1, 7, 2, 3]
>>> l.sort()
>>>

(1, 2, 3, 7, 9]
>>> len(1)

5

>>> 1[3:5]

[7, 9]

>>> 7 in 1

True

Listen sind mutable. 1ist.append(),
auf das sie wirken.

>>>
[1,
>>>
>>>
[1,
>>>
>>>
T,
>>>
>>>
1,

>>>

>>>
>>>

[1,

>>>

1

2, 3, 7, 9]
l.insert(3, "a")

1

2, 3, 'a', 7, 9]

del 1[2:4]

1

2, 7, 9]

1L += [2, 3, 4, 3, 4]
1

2, 7,9, 2, 3, 4, 3, 4]
1.count(4)

1.remove(4)
1
2, 7,9, 2, 3, 3, 4]

.sort() etc. andern das Objekt,

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python

Tupeln

o Tupeln ahneln Listen, sind aber immutable/unveranderlich.

t = (13, 4, "ABC")

o Tupeln werden ublicherweise mit runden Klammern geschrieben,

die Klammern sind aber optional:

t =13, 4, "ABC"

@ Tupeln erlauben Mehrfachzuweisungen (implicit tuple packing &

unpacking):

X, Y, Z=0, 0,1

@ Funktionen, die mehrere Werte zurtckgeben, geben Tupel zurtck:

def f(x):
return (sin(x), cos(x))

s, ¢ =T(z)

(nicht fur grof3e Vektoren, Felder, Matrizen,... geeignet)
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Strings, Listen, Tupeln sind Sequenzen

Alle Sequenz-Typen erlauben die folgenden Operationen:

x in S, x not in S | Element in Sequenz enthalten?
S[i] gibt i-tes Element von S zurlck (Zahlung ab 0)
S[i:j] gibt Subsequenz mit Elementen /, ...,j — 1 zuruck
S[i:j:K] Subsequenz mit EL i, i+ Kk, i+ 2k, ...,i +n*xk <j
S[-1] letztes Element, negative Indizes zahlen von hinten
len(S) Lange der Sequenz
min(S), max(S) kleinstes/grofdtes Element der Sequenz
S+ T Zusammenflgen von Sequenzen gleichen Typs
n xS Zusammenflugen von n Kopien
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Logische Variablen, Vergleiche, Tests

o Vergleichsoperatoren: ==, !=, <, >, <=, >=
o Tests: a in L, a not in L
liefern einen Wahrheitswert vom Typ bool, entweder True oder False

>>> X =4 > 5
>>> type(x)
<class 'bool'>
>>> X

False
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@ Boolsche Variablen und Ausdricke konnen durch die logische
Operatoren and, or, not verknupft werden.

>>> X = 4 <= 6 and 'a' in 'kaa'
>>> X
True
>>> if x:
print("hurra!")

hurra!

@ Vergleiche konnen verkettet werden:
a < b <= cisteine Kurzformfur a < b and b <= ¢
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Ablaufsteuerung - If

if x >3 and 2 < z < 5:
y=-1

elif x < 10: o elif steht fur else if
y = X + 2 @ Die elif und else-Blocke sind
z =5 optional.
else: C e . : .
y = 25 o Es kann beliebig viele elif-Blocke
, = 3 geben.

print(x, y, z)
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Ablaufsteuerung - Schleifen

Python kennt zwei Schleifenkonstrukte: while und for.

Die while test-Schleife wird abgearbeitet, wenn und solange test
wahr ist:

while x > 0:
y = x/3
X = X/2 -y

print(x, y)
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Ablaufsteuerung - Schleifen

Der Schleifenblock von while- und for-Schleifen kann die
Anweisungen break und continue enthalten:

while x > 0:

y = Xx/3
z = func( x, 2xy)
if(z == 0):
continue # beginne sofort den ndchsten Durchlauf
if y < 1:
break # breche Schleife ab
X = X/2 -y

print(x, y)




while-Schleife

eps =1

while 1 + eps != 1:
eps = eps/2

print(2 * eps)

ist identisch zu:

eps =1
while True:
if eps + 1 == 1:
break
eps = eps/2
print(2 * eps)
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for-Schleifen
Allgemeine Form
for x in <iterierbares Objekt>: J

Beispiel: Iterieren Uber eine Liste:

>>> for 1 in ["Vater", "Mutter", "Tochter"]:
print (i)

Vater

Mutter

Tochter
>>>




for-Schleifen
Das Wichtigste (fur Numerik) zum Schluss:

range

@ range(n) erzeugt ein iterierbares Objekt (einen iterator) mit den
n Elementen 0, ..,n —1

for i in range(4):
print(i**2)

druckt die 4 Zahlen: 0, 1, 4 und 9.

@ Um den Inhalt eines range-Objekts zu sehen, kann man es in eine
Liste umwandeln:

>>>list(range(4))
[o, 1, 2, 3]
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for-Schleifen
range

o range hat die 3 Formen
® range(Stopwert)
® range(Startwert, Stopwert)
® range(Startwert, Stopwert, Zuwachs)

>>> list(range(10))

[0, 1, 2, 3, 4, 5, 6, 7, 8, 9]
>>> list(range(3, 10))

[3, 4, 5, 6, 7, 8, 9]

>>> list(range(3, 10, 2))

[3, 5, 7, 9]

>>> list(range(3, 10, 4))

[3, 7]

>>> list(range(10, -4, -1))
[ie, 9, 8, 7, 6, 5, 4, 3, 2, 1, 0, -1, -2, -3]
>>> list(range(3, 3))

[]
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Mit Hilfe eines Index uber eine Liste L iterieren:

def sum(L):
s =0
for i in range(len(L)):
s += L[i]
return s

oder besser: direkt Uber die Elemente der Liste iterieren:

def sum(L):
s =20
for x in L:
S += X
return s
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Interaktive Hilfe

print(x) Zeige Objekt x
type(x) Zeige Typ (Klasse) von x
help(x) Zeige Docstrings/Hilfe zu x

dir(x) Zeige Methoden, members, member functions, etc von x

Beispiele (bitte mal ausprobieren!):

dir(list)
help(list)
dir(str)
help(str)

help() # startet interaktive Hilfe

import math; dir(math)

import math; help(math)

import datetime; help(datetime.time)
import fractions; help(fractions)
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Ganze Zahlen

o ubliche Arithmetik +,-,*,/ Potenz xx, //, %

@ Zahlen vom Typ int konnen beliebig grof® werden:
3xx55 => 174449211009120179071170507

@ Division erzeugt immer FlieRkommazahlen 3/3 => 1.0
Integer-Division // rundet nach —oo

25//7 => 3, -25//7 => -4

@ Der Operator % liefert Rest der Ganzzahl-Division 25%7 => 4
so dass immer

(a//b)*xb + a%b = a
gilt
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Ganze Zahlen in anderen Sprachen

@ Die meisten Programmiersprachen haben Integers mit fester Lange
von n Bits (n = 32, 64) —> schneller

o Wertebereich: —2"1! < n < 2011
o Arithmetik ist modulo 2", keine Fehlermeldung beim Uberlauf

>>> import numpy as np

>>> np.iinfo(np.int32)

iinfo(min=-2147483648, max=2147483647, dtype=int32)
>>> 2%%31

2147483648

>>> np.iinfo(np.int64)
iinfo(min=-9223372036854775808, max=9223372036854775807, dtype=int64)
>>> 2%x%063

9223372036854775808

>>> a=np.int32(2147483600)

>>> b=np.int32(200)

>>> a+b

-2147483496
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Flie3kommazahlen

o viel grofserer Zahlenbereich als ganze Zahlen begrenzter Lange
@ mit begrenzter Genauigkeit (‘Anzahl der giiltigen Ziffern”)

ox=(-1)x2%6xM

E Exponent, M Mantisse (0 < M < 1), V Vorzeichenbit

o Standard IEEE 754
Einfache Genauigkeit: 32 Bit (' float’ in C)
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1 8Bit 23 Bit
\Y% E M
Doppelte Genauigkeit: 64 Bit (’double’ in C)
1 11 Bit 52 Bit
\% E M
Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python
FlieRkommazahlen
einfach doppelt
Exponentenlange E (Bits) 8 11
kleinster Exponent en, —-125 -1021
grofdter Exponent epax 128 1024
Mantissenlange 24 53
betragsméafRig kleinste normalisierte Zahl | 1.18 x 10738 | 2.23 x 10208
grofder Null
grofdte darstellbare Zahl 3.40 x 10%® | 1.79 x 10%98
kleinste Zahl ¢, fir die 1 + € # 1 596 x 1078 | 1.11x 10716
Abstand € = 2e zwischen 1.0 und der | 1.19 x 10~/ | 2.22 x 10716
nachstgrofieren Maschinenzahl
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FlieBkommazahlen in Python

@ Pythons float sind auf 64Bit-Betriebssytemen auch 64Bit (doppelt
genaue) Flieltkommazahlen.

@ Das Modul numpy stellt auch float32, float64 zur Verfugung.

>>> 0.1 + 0.1 == 0.2

True

>>> 0.1 + 0.1 + 0.1 == 0.3
False

>>> format(0.1, '.25¢0')
'0.1000000000000000055511151"

>>>

Test auf naherungsweise Gleichheit bei FlieRkommazahlen:
eps=1.e-8
if abs(x-y) < eps:
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Das math Modul

@ Winkel im Bogenmaf3

@ sin, cos, tan, asin, acos, atan, atan2(y,x), sinh, cosh,
tanh, asinh, acosh, atanh, sqrt, exp, log, log2, loglO

ceil(a) kleinste ganze Zahl > a.
floor(a) grofite ganze Zahl < a
gcd(m, n)

© 0 0 ©o

erf(x), factorial(n), gamma(x),
Q@ e, pi
Bereits in Python eingebaut:
@ abs
@ max(al, a2 [,a3,...]), min(al,a2 [,a3,...])
o Typumwandlungen: int, float, complex, str

@ Integers in anderen Basen als Strings: bin, hex, oct, int
bin(23) -> ’'0bl10111’, int(’'10111’, 2) -> 23
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Komplexe Zahlen und das Modul cmath

>>> X=2+3]

>>> X.real

2.0

>>> X.imag

3.0

>>> x.conjugate()

(2-37)

>>> abs(x)

3.605551275463989

>>> import cmath

>>> cmath.sin(x)
(9.15449914691143-4.1689069599665657 )
>>> cmath.exp(-cmath.pi * 1j)
(-1-1.2246467991473532e-167)

>>> cmath.log(-2).1imag
3.141592653589793

>>> cmath.polar(x)
(3.605551275463989, 0.982793723247329)
>>> (r,phi)=cmath.polar(x)

>>> cmath.rect(r,phi)

(2+37)
>>>
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Zuweisungen
o Auf der linken Seite muf3 ein Objekt stehen: x + y =—sin(z)
o Zuweisungen sind keine Werte: if (x=si < 0:
(@aber x =y = z = 3ist erlaubt)

Arithmetische Operationen
o Division ist a/b, nicht a: b. Multiplikationsoperator ist notig:

2(x + y)) 2*%(x + 3xsqrt(y))
o *,/ bindet starkerals+~- a + b *x c = a + (b * )
o x,/,+,- sind linksassoziativ a / b / c = (a / b) / c
a/bxc = (a/b) *x c

o ax*b ist der Potenzoperator a”.
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Rangfolge und Assoziativitat

()

+ -
== != P I — G — in

not

and

or
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Beispiel:
2xa*x*3 + 5 =0 and not x == 0 ory > 1

wird interpretiert als:
((((2x(ax%x3)) + 5) !'=0) and (not (x == 0))) or (y > 1)

Naturlich ist auch niemand bose, wenn man einige der Klammern
hinschreibt:

((2xa**x3 + 5 !=0) and (not x == 0)) ory >1



Noch etwas Syntax

@ Operationender Forma = a © b konnenals a ©= b
geschrieben werden:
X /= 2; L += [x]; 1 4= 1; str += '\n’

@ Die Tue-nix-Anweisung: pass

if x == 0:
pass
else:

o List comprehension

® Erzeugt aus einer Liste/Generator eine neue Liste ohne explizite
Iteration
® ihnelt der mengentheoretischen Notation M = {2x | x € L,x* > 55}
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List comprehension

>>> [ 2*x1 for i in range(10)]

[1, 2, 4, 8, 16, 32, 64, 128, 256, 512]

>>> L = [ 2xx1 for i in range(10)]

>>> |

[1, 2, 4, 8, 16, 32, 64, 128, 256, 512]

>>> [ 3xx for x in L ]

[3, 6, 12, 24, 48, 96, 192, 384, 768, 1536]
>>> [ 3xx for x in L if x > 30 ]

[96, 192, 384, 768, 1536]

>>> from math import sqrt

>>> [sqrt(x) for x in range(8) if x%2 == 0]
[0.0, 1.4142135623730951, 2.0, 2.449489742783178]
>>>
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Funktionen

o startet mit def
@ im Allgemeinen mindestens eine return-Anweisung
@ eigener namespace: Variablen sind lokal

def posdiff(a, b):

z=a-b
if z > 0:
return z
else:
return -z
X = posdiff(44, 55) # hier ist z unbekannt
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Funktionen

@ Eine Funktion, die ohne return endet, gibt das spezielle Objekt
None zuruck:

>>> def g(z):
print("hihi")

>>> X = g(33)
hihi

>>> X

>>> type(Xx)
<class NoneType>
>>> x==None

True

>>> print(x)
None

>>>

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python

57/75

58 /75



Funktionen

Bei der Definition einer Funktion...

o Funktionsargumente konnen default-Werte haben. Argumente mit
default-Wert mussen nach den Argumenten ohne default stehen.

def Nullstellensuche(x0, x1, eps=l.e-8, MaxIter=1000):

Nullstellensuche(a, b)
Nullstellensuche(a, b, 1l.e-10)
Nullstellensuche(a, b, 1.e-10, 2000)

N N N
nm un n

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python 59/75

Funktionen

Beim Aufruf einer Funktion...

o Funktionsargumente konnen statt durch ihre Position in der
Argumentliste durch ihren Namen identifiziert werden.
Benannte Argumente mussen nach den Argumenten ohne Namen
stehen.

def func(x0, x1, x2, eps=l.e-8, MaxIter=1000):

die folgenden Aufrufe sind alle aquivalent:
func(a, b, b2, 1.e-10 )

func(eps=1.e-10, x1=b, x2=b2, x0=a)
func(a, eps=1l.e-10, x1=b, x2=bl)

N N N %
1
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Funktionen

Funktionen sind ganz normale Objekte

@ Sie konnen von Funktionen erzeugt und als Ergebnis returnt

werden.

>>> def generate_add_func(x):
def addx(y):
return x+y
return addx

>>> h = generate_add_func(4)
>>> h(1)

>>> h(2)
>>> h(10)

14
>>>
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Funktionen

Funktionen sind ganz normale Objekte

o Sie konnen als Argumente an Funktionen ubergeben werden.

>>> def Riemann_integrate(f, a, b, NInter=1000):
delta = (b-a)/NInter
s =0
for i in range(NInter):
s += delta * f(a + delta/2 + i * delta)
return s

>>> from math import sin, pi

>>> Riemann_integrate(sin, 0, pi)
2.0000008224672694

>>> Riemann_integrate(sin, 0, pi, NInter=3000)
2.00000009138523

>>> Riemann_integrate(sin, 0, pi, NInter=300)
2.000009138551823

>>> Riemann_integrate(sin, 0, 2xpi)
-3.1508609198323267e-16

>>>

Meik Hellmund (Uni Leipzig) Wiss. Programmieren in Python

61/75

62/75



Funktionen und globale Variablen
Globale Variablen sind innerhalb von Funktionen lesbar:

my_pi = 3.14

def umfang(r):
u=2=*my_pi*r
return u

Um globale Variablen innerhalb einer Funktion zu modifizieren, mussen

sie als global deklariert werden (ansonsten wird eine lokale Variable
gleichen Namens angelegt):

my_pi = 3.14

def improve_my_pi():
global my_pi
my_pi = 3.14159

print(my_pi) # druckt 3.14

improve_my_pi()

print(my_pi) # druckt 3.14159
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Ein- und Ausgabe - Konsole
Direkte Ein- und Ausgabe: input () und print()

answer = input('Bitte Zahl eingeben!') # answer ist ein string
a = int(answer) # Konvertierung
b = a**3

print('Die Antwort ist ', b)

Fehlerbehandlung:
from sys import exit
answer = input('Bitte Zahl eingeben!') # answer ist ein string
try:

a = int(answer) # Versuche, ob konvertierbar
except ValueError: # wenn nicht:

print('Das war keine ganze Zahl!"')

exit()
b = a**3

print('Die Antwort ist ', b)
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Stringformatierung

Ziel: ,schon” formatierte Ausgaben/Tabellen

X = 33

y = 44.3

print( " x= {} y= {}".format(x, y) )
# druckt: x= 33 y=44.3

@ Strings haben eine format ()-Funktion, womit Platzhalter der
Form {} durch Werte/Variablen ersetzt werden.

@ Innerhalb des Platzhalters {} konnen Formatierungsanweisungen
stehen.
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>>> x='Klaus'
>>> "Vorname: {}; Name: {}".format(x, "von und zu Minchhausen")
'"Vorname: Klaus; Name: von und zu Minchhausen'

rechtsbiindig, mind. 20 Zeichen:

>>> "Vorname: {:>20}; Name: {:>20}".format(x, "von und zu Minchhausen")
'"Vorname: Klaus; Name: von und zu Minchhausen'

linksbiindig, mind. 20 Zeichen:

>>> "Vorname: {:<20}; Name: {:<20}".format(x, "von und zu Minchhausen")
'"Vorname: Klaus ; Name: von und zu Minchhausen'

zentriert

>>> "Vorname: {:720}; Name: {:720}".format(x, "von und zu Minchhausen")
"Vorname: Klaus ; Name: von und zu Minchhausen'

rechtsbiindig, auf 20 Zeichen kiirzen

>>> "Vorname: {:>.20}; Name: {:>.20}".format(x, "von und zu Minchhausen")
'"Vorname: Klaus; Name: von und zu Minchhaus'

rechtsbiindig, mind. 12 Zeichen, auf 18 Zeichen kirzen

>>> "Vorname: {:>12.18}; Name: {:>12.18}".format(x, "von und zu Minchhausen")
"Vorname: Klaus; Name: von und zu Miinchha'

linksblindig, 12 Zeichen Platz, auf 4 Zeichen kiirzen

>>> "Vorname: {:<12.4}; Name: {:<12.4}".format(x, "von und zu Minchhausen")
"Vorname: Klau ; Name: von '
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Integers

>>> x=7831678
>>> " x = {}".format(x)

' x = 7831678'
>>> " x = {:20d}".format(x) # rechtsbindig mind. 20 Zeichen
''x = 7831678
>>> " x = {:<20d}".format(x) # linksblndig
' x = 7831678 '
>>> " x = {:720d}".format(x) # zentriert
''x = 7831678 '
>>> " x = {:4d}; y= {:4d}".format(x, 2) # Ints werden nicht abgeschnitten
' x = 7831678, y= 2"

Andere Basen:

>>> "Basis 8: {:0}; Basis 16: {:x}; Basis 2: {:b}".format(x,x,Xx)
'Basis 8: 35700176; Basis 16: 77807e; Basis 2: 11101111000000001111110'
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Floats

o f-Format: Dezimalzahlen

>>> X = 56231.789
>>> "Res= {:>13.5f}".format(x) # 13 Zeichen Platz, 5 Nachkommastellen
'Res=  56231.78900'

o e-Format: Exponentialschreibweise

>>> "Res= {:>13.5e}".format(x) # 13 Zeichen Platz, 5 Nachkommastellen
'Res=  5.62318e+04'

@ g-Format: Dezimal- oder Exponentialschreibweise, grofenabhangig

>>> "Res= {:>13.8¢g}".format(x) # 13 Z. Platz, 8 Gesamtstellen(!)
'Res= 56231.789'
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Dateibasierte Ein- und Ausgabe

o Offnen der Datei f=open(...)

o Lesen aus der Datei/Schreiben in die Datei
f.readline()/f.write()

o SchliefRen der Datei f.close()

I/0 ist ein weites Feld. Wir betrachten einige wenige der zur Verfligung
stehenden Funktionen.
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f = open('datei.txt', 'r'")

@ 1. Argument ist der Dateiname, der auch einen Pfad enthalten
kann, z.B. '../daten/datei2.dat’, r’c:\user\max\datei3’
@ 2. Argument:
® 'r’read
® 'w’ write (vorhandenes uberschreibend)
® ’'a’ append (fortschreibend)

o Fehlerbehandlung:

from sys import exit
try:
f = open('datei.txt', 'r'")
except IOError as e:
print(e) # Fehlermeldung
exit()
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Beispiel: Datei schreiben

fl = open('datei.txt','a')
fl.write(' X y z\n')
for i in range(100):

fl.write( "{:20.10g} {:20.10g} {:20.10g}\n".format(x[i] ,y[il ,z[il) )

fl.close()

Bei .write() mussen Zeilenumbruche "\n’ explizit angegeben werden.

Beispiel: Datei lesen

f2 = open('tabellel.txt','r")
f2.readline() # skip first line
f2.readline() # skip second line

# file objects are sequences of lines
# so we can iterate over lines

for 1 in f2: # 1= 1 3.44 5.66\n'
Lst = l.split() # Lst= ['l', '3.44', '5.66']
n = int(Lst[0])
x = float(Lst[1]) # type conversion
y = float(Lst[2])

f2.close()
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Datei sehe so aus:

Nummer Lange Breite
1 3.44 5.66
2 6.32 7.08
3 12.00 9.32
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Klassen

class Punkt:
"""simple class of points in the cartesian plane"""

def __init__(self, x , y):
self.x = x
self.y =y

def translate(self, deltax, deltay):
self.x += deltax
self.y += deltay

def __str__(self):
return("Punkt bei ({}, {})".format(self.x, self.y) )

Da Python keine Variablendeklarationen kennt, werden die Attribute eines
Objekts vom Konstruktor __init__() angelegt.
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Klassen

>>> pl = Punkt(2, 3) # hier wird __init__ aufgerufen

>>> pl.x

2

>>> print(pl) # hier wird __str__ aufgerufen

Punkt bei (2, 3)

>>>

>>> pl.translate(-3, 4.5)
>>> print(pl)
Punkt bei (-1, 7.5)

>>>
>>> p2 = Punkt(0, -7)
>>> p2_y = 8

>>> print(p2)
Punkt bei (0, 8)

>>>
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Vererbung & operator overloading

class Vec(Punkt):
def __add__(self, other):

return(Vec(self.x + other.x,
self.y + other.y ))

#def __sub__(self, other):
#def __mul__(self, other):
#def __neg__(self):

# usw. ..

def __str__(self):
return("Vektor({}, {})

".format(self.x, self.y) )

>>> vl = Vec(7, 8)
>>> v2 = Vec(-11, 2)
>>> y3 = vl + v2

>>> print(v3)
Vektor(-4, 10)
>>> vl.translate(3, 3)
>>> print(vl)
Vektor (10, 11)

# __1init__ von Punkt geerbt

# hier wird __add__ aufgerufen

# .translate() von Punkt geerbt
__str__ umdefiniert

H*




